History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Change Made</th>
</tr>
</thead>
<tbody>
<tr>
<td>11-10821-03</td>
<td>12/98</td>
<td>Updated for BD™ Worklist Manager software v3.3</td>
</tr>
<tr>
<td>349197</td>
<td>7/05</td>
<td>Revised for Mac OS X</td>
</tr>
<tr>
<td>344006</td>
<td>7/05</td>
<td>Changed title</td>
</tr>
</tbody>
</table>
# Contents

## About This Manual
- Conventions ........................................ viii
- Limitations ....................................... ix
- Technical Assistance ............................ x

## Chapter 1: Introduction
- BD FACS Loader Overview .................... 12
  - Tube Loader Components .................... 13
  - Rack ............................................. 15
  - Keypad .......................................... 15
- Requirements .................................... 17
  - Hardware ....................................... 17
  - Software ....................................... 17
- Installing the Software ....................... 18
- Launching the Software ....................... 20
- Quitting the Software ......................... 21

## Chapter 2: Becoming Familiar with BD FACS Loader Software
- Worklist Manager Application Window ........ 24
- Loader Manager Status Window ................ 26
  - Computer-Controlled Mode .................. 27
  - Manually Controlled Mode ................... 27
Chapter 3: Getting Started

Preparing an Acquisition Document ........................................ 38
Defining a BD CellQuest Pro Experiment Document ................. 38
Defining a BD Multiset Schedule Document .............................. 42
Signing In ........................................................................... 43
Setting Up the Assay ............................................................. 44
Accessing BD FACSComp Software ........................................ 50
Creating a Worklist .............................................................. 52
   Entering Sample Information ............................................ 54
   Importing Sample Information ......................................... 56
   Specifying the Starting Point for the Run ......................... 62
Assigning Racks ................................................................. 63

Chapter 4: Running Samples

Setting Up the Loader ............................................................ 68
Running Samples .................................................................. 70
   Pausing Acquisition ....................................................... 72
   BD CellQuest Pro Options During Acquisition .................. 74
   BD Multiset Options During Acquisition ............................... 75
Rerunning a Full Entry .......................................................... 78
Viewing the Summary Report ............................................... 79

Chapter 5: Maintenance

Loader Shutdown ................................................................. 82
About This Manual

*BD FACS Loader Reference Manual* describes how to set up and use the BD FACSTM Loader for automated sample introduction into a BD FACS CaliburTM flow cytometer. This manual is intended for laboratory personnel and flow cytometry operators experienced in general flow cytometric applications. For information on operating your instrument, refer to the instrument guide.

This reference manual assumes you have a working knowledge of BD CellQuest™ Pro software, other BD clinical software, and the Mac® OS X operating system. If you are not familiar with the Macintosh® computer, refer to the documentation provided by Apple, Inc.

Before using BD™ Worklist Manager or BD™ Loader Manager software, review the BD FACStation™ ReadMe file that was copied to your hard disk during software installation. This file contains late-breaking information that is not printed in this reference manual.
Conventions

The following tables list conventions used in this guide.

Table 1  Hazard symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Caution, hazard, or unsafe practice that could result in material damage, data loss, minor or severe injury, or death</td>
</tr>
<tr>
<td></td>
<td>Electrical danger</td>
</tr>
<tr>
<td></td>
<td>Laser radiation</td>
</tr>
<tr>
<td></td>
<td>Biological risk</td>
</tr>
</tbody>
</table>

a. Although these symbols appear in color on the flow cytometer, they are in black and white throughout this reference manual; their meaning remains unchanged.

Table 2  Text and keyboard conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tip</td>
<td>Highlights features or hints that can save time and prevent difficulties</td>
</tr>
<tr>
<td>NOTICE</td>
<td>Describes important features or instructions</td>
</tr>
<tr>
<td>Italics</td>
<td>Italics are used to highlight book titles and new or unfamiliar terms on their first appearance in the text.</td>
</tr>
<tr>
<td>&gt;</td>
<td>The arrow indicates a menu choice. For example, “choose File &gt; Print” means to choose Print from the File menu.</td>
</tr>
<tr>
<td>Command-X</td>
<td>Keyboard shortcuts use the Command key (⌘) in combination with another indicated keystroke. For example, Command-K means to hold down the Command key while pressing the letter K.</td>
</tr>
</tbody>
</table>
Limitations

- For In Vitro Diagnostic use.

- Samples containing BD Trucount™ beads should be vortexed immediately before placing them on the instrument.

- BD Biosciences has not validated Loader mixing for volumes greater than 1 mL.

- Not all manufactured 12 x 75-mm test tubes have been checked for proper functionality on the BD FACS Loader. BD Biosciences has validated only disposable 12 x 75-mm BD Falcon™ capped polystyrene test tubes (Catalog No. 352058).

- When you interrupt a Worklist, do not remove and replace racks until a message instructs you to do so.

- If you need to reinstall any software you use with BD Worklist Manager software, you must launch that software to enter registration information, and then quit the application before launching Worklist Manager.
Technical Assistance

For technical questions or assistance in solving a problem:

- Read the section of the reference manual specific to the operation you are performing.
- See Chapter 6, Troubleshooting.

If additional assistance is required, contact your local BD Biosciences technical support representative or supplier.

When contacting BD Biosciences, have the following information available:

- product name, part number, and serial number
- any error messages
- details of recent instrument performance

For instrument support from within the US, call (877) 232-8995, prompt 2, 2.

For support from within Canada, call (888) 259-0187.

Customers outside the US and Canada, contact your local BD representative or distributor.
Introduction

The following topics are covered in this chapter:

- BD FACS Loader Overview on page 12
- Requirements on page 17
- Installing the Software on page 18
- Launching the Software on page 20
- Quitting the Software on page 21
BD FACS Loader Overview

The BD FACS Loader provides automated introduction of prepared samples to BD FACSCalibur flow cytometers. The Loader is controlled by BD Worklist Manager software which communicates with other BD software to provide a total system of automated data collection and analysis.

Use BD software such as BD CellQuest Pro or BD Multiset software to set acquisition criteria; use Worklist Manager software to input sample information and specify data file storage. Load the racks, click Run Tests, and Worklist Manager automatically runs the samples and provides status updates during the run. When the Worklist is completed, you can print a Summary Report that lists the files saved and status of each sample.

The BD FACS Loader consists of a sample tube loading device, remote keypad control, and an electronics module. The Loader can be operated manually via the keypad control, or automatically via Worklist Manager software.
Figure 1-1  BD FACS Loader on a BD FACSCalibur flow cytometer

Tube Loader Components

The sample tube loading device is mounted directly on the flow cytometer. The device consists of a drive system, tube lifter mechanism, rack spindle, and optical sensors, all of which are attached to a sliding drawer.
The tube lifter is a stainless steel rod that lifts the sample tube from the rack to the sample injection port (SIP). The speed and distance of the lifter are optimized, and should not be changed unless you are instructed to do so by BD Biosciences.

There are two optical sensors. One reads the rack ID to verify the rack installed is correct. The other scans the rack to verify the tube locations match the associated Rack Manifest. It also verifies a tube is in place before activating the tube lifter and that a tube is returned to the rack when the tube lifter is lowered.

To operate the Loader, the cover must be in place on the Loader drawer. Tubes will not be loaded if the cover is off, and currently running tubes will be unloaded if the cover is removed during a run.

The only modifications necessary for the cytometer to work properly with the Loader are removing the Bal seal and installing the tube guide and Loader seal on the SIP. This helps to provide proper installation and pressurization of the tubes during acquisition.
Note that you can return the cytometer to its original state if you want to install tubes manually on the cytometer without using the Loader. For instructions, see Modifying the Cytometer for Non-Loader Use on page 95.

**Rack**

The Loader rack can accommodate up to forty 12 x 75-mm tubes in its labeled tube locations. Each rack has a rack ID (1–16) printed on its top and on an optically read label on the inner surface of the rack. The rack is positioned on the rack spindle within the Loader drawer (Figure 1-2 on page 14), which slides in and out for easy access.

Note that the Loader is compatible with both the traditional Loader racks (gray) and the newer, greenish racks labeled “Sample-Prep Ready” (Figure 1-3).

![Figure 1-3 Loader rack](image)

**NOTICE**  Not all manufactured 12 x 75-mm test tubes have been checked for proper functionality on the Loader. BD Biosciences has validated only disposable 12 x 75-mm BD Falcon capped polystyrene test tubes (Catalog No. 352058).

**Keypad**

The keypad (Figure 1-4) communicates with the Loader electronics module via a SCSI cable. Use the keypad to turn the Loader power on and off, and to operate the Loader manually. (The keypad keys are disabled during a Worklist run.)
Each time the Loader is turned on and the cover is in place, the Loader performs an initialization scan. The LED display on the keypad shows the status of the Loader. After a successful scan, the Loader status reads Tube 01.

During manual operation, press the buttons on the keypad to perform the following functions:

- **Rack**—advances the rack to another position
- **Lifter**—raises or lowers a tube
- **Mixing**—vibrates the rack to mix samples in the sample tubes

Press and release the button for a short (Low) mix; press and hold the button for 2 seconds for a longer (High) mix.
Requirements

Hardware

- BD FACSCalibur flow cytometer
- BD FACStation Macintosh® computer purchased through BD Biosciences

Other platforms might be supported; contact your BD Biosciences representative for more information.

**NOTICE** If you have an external modem on your system, BD recommends turning it off while running our software.

Software

See the *Read Before You Install* file on the BD FACStation CD for specific version requirements.

- Mac® OS X
- BD Worklist Manager requires Mac OS X versions of the following BD FACStation software applications. Refer to the *Read Before You Install* file for version compatibility.
  - BD Loader Manager—for communication with the Loader electronics module
  - BD CellQuest Pro or BD Multiset (or both)—for acquisition and analysis
  - BD FACSComp™—for instrument quality control (optional; instrument settings can also be generated using BD CellQuest Pro or BD Multiset software)
Installing the Software

Note that BD Worklist Manager and Loader Manager software are already installed on BD FACStation systems purchased from BD Biosciences. Use these instructions if you need to reinstall or upgrade the software.

1. Turn on your computer.
2. Insert the BD FACStation software CD into the CD-ROM drive.
3. Double-click the CD icon that appears on the desktop.
   A window appears showing the CD contents. The BD FACStation software CD includes several BD applications and corresponding electronic documentation. Review the BD FACStation ReadMe file for more information.
4. Double-click the installer icon.
5. Enter your password, and click OK.
   You must have Administrator access to install the BDPAC device driver and the security module software, thus a password is required.
   After you click OK, the BD FACStation splash screen appears.
6. Click Continue; review the information in the ReadMe file window.
   Click Print to print a copy of the ReadMe file. Note that a copy of the file is saved in the BD Applications folder after software installation.
7. Click Continue, and then Install to install all BD FACStation software applications.
   The Installer automatically loads BD Worklist Manager software, BD Loader Manager software, and all support files to your hard disk. A message appears when installation is complete.
8. Click Quit when you see a message reporting that installation was successful; restart the computer.
The software installer creates a BD Applications folder and BD Files folder on the hard disk. If another BD application was installed previously, these folders already exist and the installer adds the new files to these folders. See the following figure.

Note that BD Multiset software also installs an alias to its PanelReagentFile in the ClinApps Info Folder in the BD Applications folder. This alias must be present for BD Multiset software to work with Worklist Manager.

Review the ReadMe files for the applications you will be using.

A ReadMe file is installed in the corresponding folder for each BD FACStation application. These files contain important information about the new features, defect corrections, and known issues with the software. Carefully review each applicable file.
Launching the Software

BD Worklist Manager software will not launch if other BD applications are already running. In addition, other BD applications cannot be launched independently while Worklist Manager is running.

Before you use Worklist Manager with BD CellQuest Pro, BD Multiset, or BD FACSComp software, you must first launch that application once to register the software, and then close the application before launching it with Worklist Manager. This also applies if you have upgraded these applications.

Before launching BD Worklist Manager software, make sure the security module included with your BD FACStation CD is plugged into a USB port on your keyboard or computer. The security module is needed to launch BD CellQuest Pro software.

Launch Worklist Manager in one of the following ways.

- Navigate to the Worklist Manager application icon in the Finder window and double-click the icon.

  **Tip**  After launching the application, press the Worklist Manager icon in the Dock and choose Keep In Dock. You can then open the application by clicking its icon in the Dock.

- Double-click the icon for a saved Worklist document or Summary Report.

Note that Loader Manager software is launched automatically when Worklist Manager starts up. To launch Loader Manager separately, you must first quit Worklist Manager before launching Loader Manager.
Registering the Software

The first time you launch Worklist Manager, a registration dialog appears.

Enter your name and the name of your institution, and click Save.

Quitting the Software

**NOTICE** You cannot quit BD Worklist Manager software while a Worklist is being run.

To quit the software, choose Quit Worklist Manager from the Worklist Manager menu, or hold down the Command key while you press the Q key (⌘-Q).
Becoming Familiar with BD FACS Loader Software

The following topics are covered in this chapter:

- Worklist Manager Application Window on page 24
- Loader Manager Status Window on page 26
- Worklist Manager Preferences on page 28
- Worklist Manager Files on page 32
Worklist Manager Application Window

When Worklist Manager software is launched, it automatically launches Loader Manager software and checks to see if the Loader is connected. The Worklist Manager application window and the Loader Manager Status window appear on the desktop.

The application window is described in this section. For information about the Status window, see Loader Manager Status Window on page 26.

![Application window displaying Sign In view](image)

**Figure 2-1** Application window displaying Sign In view

The application window contains the following elements:

- **Menu bar**—displays application menus with the commands you will need to operate the software.

- **Icon bar**—contains a panel of icons that allow you to navigate through the software. Each icon represents a different view; the icon for the current view is highlighted. Click Accept in the button panel to advance to the next view.
view. For a description of each view, see the following section, Worklist Manager Views.

- Message box—displays noneditable status messages and prompts to assist you in operating the Loader system.
- Content area—displays a series of views that allow you to enter information specific to the run.
- Button panel—contains buttons that allow you to control the software. The pulsing button is the default button that moves you along in the program. To select this button, click it or press the Return key.

**Worklist Manager Views**

A typical Worklist Manager run starts with the Sign In view and ends with the Summary view. If you want to return to a previous view to modify information already entered, click the appropriate icon to display the view.

<table>
<thead>
<tr>
<th>Sign In</th>
<th>Set Up</th>
<th>FACSComp</th>
<th>Worklist</th>
<th>Summary</th>
</tr>
</thead>
</table>

Each view functions as follows:

- **Sign In**—Sign in to Worklist Manager software as the operator.
- **Set Up**—Define information specific to the test run.
- **FACSComp**—Launch and run BD FACSComp software.
- **Worklist**—Enter sample identification information.
- **Summary**—Lists the status of all samples run and files saved

You can save the information entered in the Sign In, Set Up, and Worklist views as a Worklist document. See Worklist Manager Files on page 32.
Loader Manager Status Window

When Worklist Manager software is launched, it automatically launches Loader Manager software and checks to see if the Loader is connected. The Loader Manager Status window appears, displaying connectivity status and whether the Loader is controlled manually or by the computer.

The Status window can appear to the side or below the Worklist Manager application window; to bring the window to the front, click the Loader Manager icon in the Dock (Figure 2-2). For an overview of the two status modes, see Computer-Controlled Mode or Manually Controlled Mode on page 27.

Figure 2-2  Loader Manager Status window and icon in Dock

Note that Loader Manager can also be launched independently of Worklist Manager software. The functionality of Loader Manager software depends on how it is launched. If it is launched by Worklist Manager software, the only item you can access is the Loader Status window. If it is launched independently, you can access cleaning, maintenance, and diagnostic functions, as described in Chapter 5.
**Computer-Controlled Mode**

The Loader enters computer-controlled mode after Run Tests is clicked in the Worklist view of Worklist Manager software. In this mode, all Loader functions are controlled by the software.

![Figure 2-3 Status during tube loading (left) or Loader run (right)](image)

You cannot quit Loader Manager software or access maintenance and diagnostic functions while in computer-controlled mode. You can only view the Loader Status window, which indicates the rack and tube number of the tube being run.

**Manually Controlled Mode**

The Loader is in manually controlled mode when Worklist Manager software is running but no Worklist is being run, or when Loader Manager software is launched independently. In this mode, the Loader keypad keys are enabled.

![Loader Status](image)

Cleaning and maintenance and diagnostic functions are available only when Loader Manager software is launched independent of Worklist Manager software.
Worklist Manager Preferences

You can change certain default settings and customize the program using Worklist Manager preferences. When you save a Worklist document, any preferences you set are saved with that document.

To access preferences, choose WorklistManager > Preferences.

The following preferences are available:

- Loader Preferences, described on this page
- Columns Preferences on page 30

Loader Preferences

Use Loader Preferences to connect the Loader to the computer and to define rack IDs. Note that Worklist documents can be generated on computers not connected to a Loader.

1  Choose WorklistManager > Preferences.
2 Select the checkbox for *Loader connected to workstation*.

Deselecting this box allows you to generate a Worklist on a computer not attached to the Loader. Loader Manager software is not launched when Worklist Manager is launched if Preferences indicates the Loader is not connected. In addition, the Assay Settings button in the Set Up view and the Run Tests and Assign Racks buttons at the Worklist view are not available.

3 Define Allowable Rack IDs.

Enter the correct number for the Minimum and Maximum field to define the racks available for assignment to a system; 1 is the default setting for Minimum and 16 is the default setting for Maximum.

Consider the following when selecting rack ID ranges.

- Rack IDs that fall outside the entered range cannot be assigned in the Assign Racks dialog.
- If you open a Worklist containing un-run entries with out-of-range rack IDs, these entries will revert to being unassigned.
- If you open a Worklist with entries already run with racks that are out of range, these entries will revert to being unassigned. You will not be able to assign new rack IDs to these entries since they have been run.
- If you change the Rack ID preference after completing a Worklist, an error dialog appears when you press Run Tests.

*Chapter 2: Becoming Familiar with BD FACS Loader Software* 29
• If you try to install a rack with an out-of-range ID, an error dialog appears with the message that an unassigned rack is on the Loader.

4 Click Save.

**Columns Preferences**

Up to three custom columns can be added to the right of the Case Number column in the Worklist view. Any information entered into these columns is stored in the text section of FCS data files. Do the following to add custom columns.

1 Choose WorklistManager > Preferences, and click the Columns icon.

![Preferences dialog](image)

2 Select the checkboxes to add up to three custom columns; enter column titles, as needed.

Column titles can consist of up to 20 characters. The default names are *Column #1*, *Column #2*, and *Column #3*.

You do not have to use these columns sequentially; select the first and the third, if you want (Figure 2-4 on page 31).
Figure 2-4  Selecting columns out of order

3  Click Save.

Custom columns appear to the right of the Case Number column in the Worklist view. Titles appear exactly as they were entered.

The preferences are saved by Worklist Manager software and apply to all new Worklists.
Worklist Manager Files

Worklist Manager can create two types of files. Note that Flow Cytometry Standard (FCS) data files are saved by the appropriate application software, not by BD Worklist Manager software.

Worklist Document Files

The Worklist document file contains all data entered at the Sign In, Set Up, and Worklist views, as well as preferences. You can save a Worklist document and open it later to view, to complete processing, or to add more samples for processing. If you open a partially run Worklist and continue to run it, the Summary Report is updated to contain information for the entire run.

If you attempt to close the Worklist Manager application window or quit the program before saving the Worklist document, a dialog appears asking if you want to save the Worklist document. Only one Worklist document can be open on the desktop at a time.

This version of the software can read Worklist documents from Worklist Manager version 3.3 or later.

Summary Report Files

A Summary Report file contains a list of the samples run, the name of the data files saved, and the status of the run. When you save a Summary Report file, the suffix .sum is appended to the file name. Summary Reports are saved as a PDF file.

A Summary Report can be printed at the conclusion of each run. You can open as many Summary Reports as computer memory allows.
File Naming

Worklist Manager files are named by their creation date, by default.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Naming Convention</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worklist document file</td>
<td>DDMMYY.wrk</td>
<td>150403.wrk</td>
</tr>
<tr>
<td>Summary Report file</td>
<td>DDMMYY.sum</td>
<td>150403.sum</td>
</tr>
</tbody>
</table>

You can change the default file names (DDMMYY) for these files. To rename a Worklist document, choose Save or Save As at any view and enter a new name in the standard Save dialog. To rename a Summary Report, click the Location button in the Set Up view. (See Setting Up the Assay on page 44.)

Output File Naming

When running a BD CellQuest Pro Experiment document or a BD Multiset Schedule document, Worklist Manager can generate data files and export files. Worklist Manager software can also generate up to three types of reports when running a BD Multiset schedule document.

The default name for all files contains at least three parts:

(Prefix)(Entry Number).(Tube Number)

- The file name prefix is selected in the Set Up view. (See Setting Up the Assay on page 44.)
- The entry number corresponds to the Worklist line number, from 01 to 99. (See Creating a Worklist on page 52.)
- The tube number is indicated by tube position in a panel and ranges from 001 to 040 (for BD CellQuest Pro documents) or 01 to 40 (for BD Multiset documents) with 40 being the maximum number of tubes per panel.
To illustrate:

<table>
<thead>
<tr>
<th>BD CellQuest Pro file</th>
<th>BD Multiset file</th>
</tr>
</thead>
<tbody>
<tr>
<td>JaneDoe03.002</td>
<td>JaneDoe03.02</td>
</tr>
</tbody>
</table>

indicates Jane Doe is the third entry in the Worklist, and this file is from the second tube in the panel.

To prevent an original file from being overwritten, the helper application adds a unique character to a file name under the following circumstances.

**File-Naming Conflict During a Run**

The application attempts up to five times to give the new file a unique name by adding an uppercase letter (V through Z) after the tube position. Thus, the following file names illustrate the first and second attempts to resolve a conflicting file name. The Worklist is aborted if it attempts to rename a file more than five times.

<table>
<thead>
<tr>
<th>BD CellQuest Pro file</th>
<th>BD Multiset file</th>
</tr>
</thead>
<tbody>
<tr>
<td>JaneDoe03.002V</td>
<td>JaneDoe03.02V</td>
</tr>
<tr>
<td>JaneDoe03.002W</td>
<td>JaneDoe03.02W</td>
</tr>
</tbody>
</table>

For a conflict in naming a BD Multiset report, the application attempts up to ten times to give the new file a unique name by adding an uppercase letter (Q through Z) after the report name. To illustrate:

<table>
<thead>
<tr>
<th>BD Multiset report</th>
</tr>
</thead>
<tbody>
<tr>
<td>test03.labQ (1st attempt)</td>
</tr>
<tr>
<td>test03.labR (2nd attempt)</td>
</tr>
<tr>
<td>test03.labW (7th attempt)</td>
</tr>
</tbody>
</table>
**Naming a Rerun Tube**

You can rerun a tube up to five times. The application adds a lowercase letter, (a through e) to each subsequent file, placing the appropriate letter after the entry number to indicate a full-entry rerun or after the tube number to indicate a single-tube rerun.

The following illustrates the first and second reruns for a BD CellQuest Pro file (CQP) named test01.003 and a BD Multiset file (MS) named test 01.03.

<table>
<thead>
<tr>
<th>Full-Entry Rerun</th>
<th>Single-Tube Rerun</th>
</tr>
</thead>
<tbody>
<tr>
<td>test01a.003 (CQP)</td>
<td>test01.003a (CQP)</td>
</tr>
<tr>
<td>test01a.03 (MS)</td>
<td>test01.03a (MS)</td>
</tr>
<tr>
<td>test01b.003 (CQP)</td>
<td>test01.003b (CQP)</td>
</tr>
<tr>
<td>test01b.03 (MS)</td>
<td>test01.03b (MS)</td>
</tr>
</tbody>
</table>

For more information, see Rerunning a Full Entry on page 78.

**Printing and Saving Files**

**Saving a Worklist Document**

A Worklist document is stored in the computer’s temporary memory until you save it to disk. You can save a Worklist document at any time by choosing Save or Save As from the File menu. If you do not save the Worklist before clicking Run Tests, a dialog appears prompting you to do so.

Note that only one Worklist can be open at a time. To open a saved Worklist, close the application window, and then choose Open Worklist from the File menu. The saved Worklist document opens at the Sign In view.
Saving a Summary Report

You can set up the software to save a Summary Report automatically at the conclusion of a run by selecting the appropriate checkbox in the Set Up view. (See Setting Up the Assay on page 44.) You can also save a Summary Report by choosing Save Report from the File menu while at the Summary Report view.

To open a saved report, choose Open Report from the File menu. Reports can be viewed using Adobe® Acrobat® software or the Preview application included with your Macintosh computer.

Printing a Summary Report

You can print a Summary Report within Worklist Manager software by choosing Print from the File menu at the Summary view. Page and Print Setup options can also be accessed from the File menu.

Alternatively, you can open and print a saved report using the Print command in the PDF viewer application.

NOTICE   Options set in the Page Setup and Print Setup dialogs within Worklist Manager software apply only to the Summary Report and Rack Manifest printouts. Print options for BD Multiset reports are specified within BD Multiset software.
Getting Started

The following topics are covered in this chapter:

- Preparing an Acquisition Document on page 38
- Signing In on page 43
- Setting Up the Assay on page 44
- Accessing BD FACSComp Software on page 50
- Creating a Worklist on page 52
- Assigning Racks on page 63
Preparing an Acquisition Document

BD Worklist Manager software requires access to an application-specific document defined with the conditions for acquisition. When you click Run Tests at the Worklist view, Worklist Manager launches the appropriate acquisition software, using the defined document, for use with the Loader.

This section describes the following:

- Defining a BD CellQuest Pro Experiment Document on this page
- Defining a BD Multiset Schedule Document on page 42

Defining a BD CellQuest Pro Experiment Document

A BD CellQuest Pro Experiment document launched by Worklist Manager must contain the conditions for acquisition (acquisition and storage settings), and have a panel defined and selected.

Do the following to set up an acquisition Experiment document in BD CellQuest Pro software.

1. Open an existing Experiment document or create a new one.
2. Format all dot plots to Acquisition-to-Analysis plots.

   ✓ Tip   Select all plots in the document, and then choose Acquisition -> Analysis from the Plot Type pop-up menu in the Inspector.
3. Choose Acquire > Acquisition & Storage.
4. Enter the acquisition criteria in the Acquisition & Storage window; click OK when you are finished.
   - Set Collection Criteria to Event Count or Time.
   - Enter values for stopping acquisition.
Tip For walkaway operation, choose Event Count or Time for the Collection Criteria, and enter a time of less than 600 seconds (10 min.) for the stopping time. If you choose Event Count only or enter a time of more than 10 minutes, you run the risk of Worklist Manager timing out if the specified number of events is not collected during the entered time, or after after 10 minutes. During a timeout, no data is saved, and you might not have a sufficient amount of sample left to rerun.

5 Load a defined panel using the Acquisition Browser.
6 Edit the Acquisition Tube List in the Browser, if required (Figure 3-1).

To change a tube name or parameter label, select the tube icon in the Browser and make changes in the Inspector. To change the acquisition order, drag a tube icon up or down on the list.

![Figure 3-1 Acquisition Tube List]

⚠️ Do not add or delete tubes from the Acquisition Tube List in the Browser. If you want to add or remove tubes, edit the panel rather than the Acquisition Tube List. Changes made to the Acquisition Tube List are not recognized by Worklist Manager, and can negatively impact acquisition.

7 Specify tube-specific settings, if required.

Each tube in the panel can have different acquisition settings, such as the number and type of events acquired and the type of parameters saved. In addition, different instrument settings can be associated with different tubes in the panel.

To add tube-specific settings, click on the pop-up control in the Browser, add the required settings, and use the Inspector to customize the settings.

Refer to the BD CellQuest Pro Software Reference Manual for instructions.
8 Associate Acquisition plots in the Experiment document with tubes in the panel, if required.

After creating plots, you can set up one or more plots to display data only for a specific tube. Any plots that have been associated with tubes remain empty until data is acquired for the corresponding tube.

Refer to the *BD CellQuest Pro Software Reference Manual* for more information and instructions.

**Tip** If you are using this feature, deselect the checkbox to Print CellQuest Plots in the Assay Settings dialog (Figure 3-4 on page 49), accessed in the Worklist Manager Set Up view. When the checkbox is selected, the document prints after each sample is run, and only the final printout contains a complete set of data.

9 Save the defined Experiment document in the CellQuest Experiments Folder in the WorklistManager Folder.

**NOTICE** If you copy a Worklist document that uses BD CellQuest Pro software to another computer, you must also copy the Experiment document(s) and instrument settings file(s) used by that Worklist document into the appropriate folders on the other computer.
Defining a BD Multiset Schedule Document

During BD Multiset software installation, a default Schedule document is installed in the MultiSET Folder in the BD Applications folder. To run BD Multiset software with the Loader, use this default Schedule document or define your own.

A BD Multiset Schedule document launched by Worklist Manager must contain acquisition conditions, such as those specified in BD Multiset preferences, and the amount of time for viewing reports.

**NOTICE** Worklist Manager allows you to view BD Multiset reports for up to 5 seconds. All other options specified in the MultiSET Set Up view (i.e., Until “Next” Button Pressed, or a choice of >5 seconds) default to 5 seconds.

If you choose to define your own Schedule document, you must

- customize the Preferences, such as setting the export file delimiter, report printing, minimum and maximum number of events, and the conditions under which Worklist Manager will stop.

**NOTICE** Worklist Manager cannot acquire data for more than 5 minutes (300 seconds). If you select time as a stopping criteria, Total Time entries of more than 300 seconds will revert to 300 when the Schedule is run.

- verify or enter new lot IDs in the Tools > Lot IDs dialog.

Always make sure that the software lists the correct Absolute Count Bead lot ID and bead count when obtaining absolute counts using BD Trucount tubes. If you change lots, remember to input the new lot ID and bead count into the software. To obtain accurate results, it is critical that the correct Lot ID and Beads/Pellet are entered.

Absolute count bead lot information is saved with BD Multiset Schedule documents. All files within the Schedule document must be acquired with the same lot of BD Trucount tubes. When running Worklist Manager with BD Multiset software, do not mix lots of BD Trucount tubes in the same Schedule document.

- save the Schedule document in your choice of location.
Signing In

The Sign In view appears when you start Worklist Manager software.

1. Enter names for the Operator, Institution, and Lab Director.

   Enter up to 42 characters in each field. The operator name is always required. Use the tab key to move from one field to the next, or click in each field and begin typing. The information at the Sign In view is saved for subsequent sessions.

2. Click Accept to continue to the Set Up view.
Setting Up the Assay

At the Set Up view, specify settings for the assay you are running. Choose the prefix you want to attach to saved files, the sample label for the Summary Reports, and the storage locations for application-specific files and reports you want to save.

1 Select a File Name Prefix.

If you select Sample Name, Sample ID, or Case Number for the prefix, you must enter this information in the appropriate column at the Worklist view. See Entering Sample Information on page 54. If you select Custom prefix, click in the text box and enter your own file name prefix (up to 22 characters).

2 Select a Summary Report Sample Label.

These are also read from the Worklist view.
3 Select the Worklist Summary Report checkbox if you want to save this file.

Click the Location button to change the default name or storage location. See Worklist Manager Files on page 32 for details on the Summary Report file.

4 Choose the Assay Type from the pop-up menu under Automatic Savings Options.

The files you can save for the assay are listed under the pop-up menu with their checkboxes checked. Note that data files must be saved when you acquire samples using BD CellQuest Pro software with the Loader.

![Figure 3-2](image)

**Figure 3-2** Automatic saving options

The current file path appears below each available file type. The default location for data files is a dated folder (DDMMYY) located in the application's Files folder in the BD Files folder. If a file or folder no longer exists or is owned by another user, Worklist Manager displays INVALID LOCATION as the current file path.
5 Click each available Location button to change the file storage location, if necessary.

- For BD CellQuest Pro software, you can change the storage location for data files and export files. For an export file, Worklist Manager tells BD CellQuest Pro software when it is launched to export or append statistics into either the default folder location or into the new folder location you choose. BD CellQuest Pro software names the file for you by appending the word *stats* to the name of the Experiment document. Each Experiment document opened by BD CellQuest Pro software will export or append statistics to the same export file.

If statistics cannot be appended to an existing export file because the statistics selections in the document have changed, BD CellQuest Pro software creates a new export file in the same folder. If a file naming conflict occurs for the export file, Worklist Manager specifies the conflict in its Summary Report. See File-Naming Conflict During a Run on page 34.

- For BD Multiset software, you can change the storage location for data files, report files, and export files. For export files, when you change the storage location, you can choose to append data to an existing file or create a new file.

To specify the name and storage location for a new export file, click New File and enter a name in the dialog that appears. The file path displays the new name when you return to the Set Up view.

By default, Summary Reports and export files are named according to the date they are generated (see File Naming on page 33). If you change
the name for either file type, the Use Date Generated File Name checkbox is deselected when you return to the Set Up view.

To return to naming files by date, select the checkbox.

The default location for a Schedule document template is the MultiSET folder in the BD Applications folder. Click the Location button to choose another Schedule document.

**NOTICE** Make sure you have sufficient storage space for all files to be generated. If the data storage disk becomes full during acquisition, the Worklist stops.

**6** Click Assay Settings to access the Assay Settings dialog (Figure 3-3).

![Assay Settings dialog](image)
Use this dialog to associate instrument settings with a panel, customize mix settings, and to specify whether to print plots in BD CellQuest Pro software.

Note that for BD CellQuest Pro software, the dialog lists panels from all Experiment documents stored in the Worklist Manager > CellQuest Experiments folder. Panel names are followed by the Experiment document name in which they are defined (Panel name : Experiment document name).

For BD Multiset software, the dialog lists all panels defined in the software.

To set up assay settings, do the following.

- Select an application icon.

- To link an instrument settings file with each panel, click the Instrument Settings pop-up control and choose a file from the menu that appears. The menu lists all Instrument Settings files that are stored in the BD Files > Instrument Settings Files folder. BD FACSComp Calib files should be available. The No File option allows you to clear the panel/instrument settings association.

- Change the Acquisition Start Delay by clicking the arrows or using the slider control (Figure 3-3 on page 47). Acquisition Start Delay occurs after the tube is lifted and properly pressurized. It allows the flow rate to stabilize before events are saved.
- Customize mix setting(s) by clicking the arrows or using the slider control.

For BD CellQuest Pro software, mix settings are specific to each panel. Choose mix settings after you select a panel (Experiment document) from the Panel list. Every time you run that panel, these mix settings are used. Default mix settings are suggested settings for immunophenotyping.

For BD Multiset software, mix settings are common to all panels.

Click Default Settings to reset mix settings to those recommended by BD for each assay.

![Figure 3-4 Default mix settings for BD CellQuest Pro (left) and BD Multiset (right) software](image)

- To print the BD CellQuest Pro Experiment document after each acquisition, select the Print CELLQuest Plots checkbox. This turns on printing for all panels in the Worklist. This feature is most useful if your Experiment document has acquisition-to-analysis plots defined and displays the statistics necessary for your analysis. If only acquisition plots are defined, the statistics printed reflect the last events acquired, not the entire data file.

**Tip** If you have tube-specific plots in your Experiment document, note that only the final printout will contain a complete set of data. To save paper, deselect the checkbox and print the analysis only after all tubes have been acquired.
7 Click Save to return to the Set Up view.
8 Click Accept to proceed to the FACSComp view.

Accessing BD FACSComp Software

You can launch BD FACSComp software from the FACSComp view. The FACSComp view appears when you click Accept at the Set Up view.

BD Biosciences recommends that you run BD FACSComp software for instrument setup and quality control before running samples. The FACSComp view displays the current date and time as well as the pass or fail status for the four types of instrument settings files saved in the BD Files > Instrument Settings Files folder.

If you already ran BD FACSComp software to set up your instrument for this Worklist run, click Skip FACSComp to proceed to the Worklist view.
To run BD FACSComp software, click Launch FACSComp to proceed with instrument setup specific to the application you are running. Refer to the *BD FACSComp Software Reference Manual* for instructions. When the setup software is complete, manually quit BD FACSComp software; the FACSComp view reappears with the updated settings displayed.

The button panel now offers the following choices; click Continue to advance to the Worklist view.
Creating a Worklist

The Worklist view is displayed after you click the Skip FACSComp or Continue button at the FACSComp view.

At the Worklist view, you can enter sample information for up to 99 samples and associate each sample with a different panel. The Assay and Panel Name fields contain pop-up menus where you choose the type of assay and panel. For more information, see Entering Sample Information on page 54.

Alternatively, you can import sample information from a tab-delimited file, or from a worklist created using BD FACS™ Sample Prep Assistant (SPA) software. See Importing Sample Information on page 56 for instructions.

Use buttons in the button panel to assign a fixed panel and to assign (or release) racks for the Loader. If you are running more than one assay type, use the Sort by Assay button to group samples by assay.
The status icons to the left of the entry numbers indicate whether or not all necessary sample information has been entered. These icons also provide the status for each entry.

The status icons include:

- Information not entered for this entry. If no information is entered for a sample, this entry is removed from the list, and the entries that follow move up.
- File Name Prefix choice made at Set Up view (Sample Name, Sample ID, or Case Number) not entered, or Assay and Panel Name not yet defined
- File Name Prefix choice made at Set Up view (Sample Name, Sample ID, or Case Number) entered, and Assay and Panel Name entered; ready for rack assignment
- Information completed and tube location and rack ID defined; ready to run
- Sample acquired
- Error encountered during acquisition
- Currently running test

To resize columns in the Worklist view, drag column borders to the right or left. BD CellQuest Pro software does not use the last four columns (Param #1, Param #2, Param #3, and Param #4), so you can make these columns as narrow as possible. For BD Multiset software, however, you might need the first three columns to enter application-specific information such as white blood count (WBC), % Lymphs, or Absolute Lymphs.

**NOTICE** BD Multiset–specific information entered in any of these columns (Param #1, Param #2, and Param #3) must match the analysis parameters set in
the Schedule document in order to be used when Worklist Manager launches BD Multiset software.

Up to three custom columns can be added to the right of the Case Number column. Use these columns to enter additional information that will be stored in the text section of FCS data files. To add custom columns, see Columns Preferences on page 30.

**Entering Sample Information**

For all applications, you must enter information in at least one of the first three columns—Sample Name, Sample ID, or Case Number—depending on the File Name Prefix and Summary Report Sample Label you specified in the Set Up view. See Setting Up the Assay on page 44.

**Tip** To scan sample information directly from a barcode label, use the BD™ barcode scanner (Catalog No. 345037). Contact your local BD sales representative for more information.

1. Click the Sample Name field and enter the name (up to 42 characters).

   Press the Tab key to move from field to field. Press Shift-Tab to move backwards. To move up or down, press the corresponding arrow key. If the information in this field is used as a file prefix, you can type up to 22 characters.

2. Repeat for Sample ID and Case Number, if necessary.

   Remember to enter information in the first three columns based on the File Name Prefix and Summary Report Sample Label specified in the Set Up view. Note that the Assign Racks button is not available until the label type specified in the Set Up view is entered in the Worklist view.

3. Assign an assay and panel for each sample, or assign a fixed assay or fixed panel to all samples.

   - To assign individual samples, click in the Assay and Panel Name columns to activate a drop-down menu. Choose options from the available choices.
To assign all samples, click the Fixed Assay/Panel button in the button panel and make appropriate choices in the dialog that appears (Figure 3-5).

Figure 3-5  Assigning a fixed assay or panel to all samples

Use the Select Mode radio buttons to assign a fixed assay, fixed panel, or both. Select Flexible to continue making assignments one sample at a time.

Make appropriate selections from the Assay and Panel drop-down menus, and click OK. The Worklist view appears with your choices in place.

NOTICE  After assigning fixed assays or panels, you can still change settings for individual sample entries in the Assay or Panel Name fields in the Worklist view.

4  View the information in the Instrument Settings column.

The Instrument Settings column displays the instrument settings file associated with the chosen panel. To change the associated file, go back to the Set Up view and click the Assay Settings button. See step 6 on page 47.
5 Click Sort by Assay at the Worklist view if you are running multiple assays.

Worklist Manager groups all of the same assays together on the Worklist. This button is active when you complete all sample information.

BD Biosciences recommends that you always group like assays together when you are running multiple assays in the same Worklist. Since Worklist Manager can open only one application at a time, each application’s Summary Report file is renamed with every new run. In addition, launching and closing a Worklist of ungrouped applications and waiting for Loader Manager to perform a Short Clean between each different assay are time-consuming and not recommended.

6 Proceed to Assigning Racks on page 63.

**Importing Sample Information**

Sample information from a tab-delimited file, such as one generated by an LIS system, can be read into the correct columns at the Worklist view. Alternatively, you can import sample information from a Worklist created in BD FACS SPA software. For details on import file criteria, see Tab-Delimited File Criteria on page 60 or SPA Worklist Criteria on page 61.

Do the following to import a Worklist.

1 Choose File > Import Worklist (Command-I).

Note that sample information can only be imported into a new, blank Worklist; you cannot add imported information to a Worklist that is already started. In addition, the File > Import Worklist command is enabled only at the Worklist view.

2 Locate and select a file to import in the dialog that appears; click Open (Figure 3-6 on page 57).

Alternatively, double-click the file icon.

If the imported file is an XML file, Worklist Manager imports it as a SPA Worklist; otherwise, the file is imported as an tab-delimited file.
If prompted, choose a Rack ID, and click OK.

If an imported XML file does not contain information for the `<CarouselID>` tag, Worklist Manager prompts you to choose one. Choose an option from the drop-down menu.

The specified ID and tube number are automatically written to the Location field in the Worklist view.
For details on import file criteria, see SPA Worklist Criteria on page 61.

4 Review the import errors, if applicable.

A dialog appears if errors occurred during the import. Note that invalid data is not imported.

If needed, return to the SPA Worklist and correct invalid entries, save the Worklist, and re-import it.

Valid data is automatically input into the appropriate columns in the Worklist view, starting at the first available entry (indicated by a ▪).

5 Review the imported information at the Worklist view; edit missing or incorrect entries, if needed.

For SPA Worklists, if the imported Worklist does not have a <SampleName> field and you specify Sample Name for the File Name Prefix at the Set Up view, Worklist Manager copies the Sample ID to the Sample Name column.
BD Tritest™ and BD Multitest™ panels are automatically mapped to MultiSET; user-defined panels are automatically mapped to CellQuest. If no <AssayName> field is present, the assay name is mapped to MultiSET.

6 (Optional) To view information about an imported SPA Worklist, click the SPA Info button at the Worklist view.

![SPA Info](Image)

All of the keywords in the SPA <Globals> section are displayed in the SPA Info dialog. These keywords are written to the FCS file header when the acquisition software is run.

7 After importing a tab-delimited file, proceed with Assigning Racks on page 63; after importing a SPA Worklist, proceed with Setting Up the Loader on page 68.

An imported SPA Worklist already has Rack IDs assigned; you cannot enter them in Worklist Manager software.
Tab-Delimited File Criteria

Information in an imported tab-delimited file (worklist.txt) must meet the following criteria in order to be successfully imported.

- Each line in the file must correspond to an entry or sample in the Worklist view and must contain the following values in this exact order:
  
  Sample Name  
  Sample ID  
  Case Number  
  Custom Column #1  
  Custom Column #2  
  Custom Column #3  
  Assay  
  Panel Name  
  Param #1  
  Param #2  
  Param #3  
  Param #4

  All values in a line must be separated by a tab, and each line must be terminated with a return. If there is no data for a required value, periods (.) can be used as placeholders; for example:

  | DKilian | 4432 | 321 | . | . | CellQuest | IMK Lymph | . | . | . |

- The assay name must match one of the names in the Assay menu at the Worklist view.

- The panel name must exactly match one of the choices in the Panel Name menu at the Worklist view. Note that panel names are case sensitive, and spaces in the panel names must match. BD CellQuest Pro panel names must
include the Experiment document name, separated by a colon (Panel name : Experiment document name).

- For BD Multiset assays, values to be entered in the Param #1, #2, and #3 columns must be the correct type and within the expected numeric range.

**SPA Worklist Criteria**

SPA Worklists are written as XML files (*worklist.xml*) that consist of one major section, `<Worklist>`, containing a `<Globals>` section and one or more `<Sample>` sections. The following XML tags can be imported into Worklist Manager.

<table>
<thead>
<tr>
<th>Section</th>
<th>Tag</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;Globals&gt;</code></td>
<td><code>&lt;CarousellID&gt;</code></td>
<td>If missing, Worklist Manager prompts for a Rack ID during import.</td>
</tr>
<tr>
<td></td>
<td><code>&lt;UniqueCarousellID&gt;</code></td>
<td>If present, Worklist Manager prompts for a unique ID during the run.</td>
</tr>
<tr>
<td></td>
<td>All other <code>&lt;Globals&gt;</code> tags</td>
<td>are displayed in the SPA Info dialog and are written to the FCS file header when the acquisition software is run.</td>
</tr>
<tr>
<td><code>&lt;Sample&gt;</code></td>
<td><code>&lt;SampleID&gt;</code></td>
<td>Sample identifier that can be used as a file name prefix</td>
</tr>
<tr>
<td></td>
<td><code>&lt;PanelName&gt;</code></td>
<td>The name must exactly match one of the choices in the Panel Name menu at the Worklist view. BD CellQuest Pro panel names must include the Experiment document name, separated by a colon (Panel name : Experiment document name).</td>
</tr>
<tr>
<td></td>
<td><code>&lt;CarouselStartPosition&gt;</code></td>
<td>Tube location on the rack.</td>
</tr>
<tr>
<td></td>
<td><code>&lt;Status&gt;</code></td>
<td><code>&lt;Status&gt;</code> is missing until the Worklist is run. Samples with Status = Incomplete cannot be imported.</td>
</tr>
</tbody>
</table>
Specifying the Starting Point for the Run

The arrow icon to the right of the sample entry number indicates the starting point for the run. You can specify a different starting point by dragging the icon to any fully defined entry not yet run, although BD Biosciences recommends that you leave the starting arrow next to the first entry in the Worklist.

During the run, the arrow icon moves down to point to the sample currently being run.

If the arrow is pointing to a partially defined entry or a previously run entry, Worklist Manager automatically skips to the next entry not yet run and starts acquisition. If acquisition starts in the middle of the Worklist, it cycles to the beginning after it reaches the end of the Worklist and tries to run entries that have not yet been run. If you click Run Tests after all entries are run, the Summary Report appears and the end-of-run cleaning begins if it hasn’t already been done.
Assigning Racks

After defining sample information, you are ready to assign each tube to a specific rack location. Before proceeding, make sure you understand these rules for assigning racks.

- Tube positions are assigned to samples according to their order in the Worklist view, starting with Position 1.
- Tube positions are filled in unbroken sequence.
- All the tubes from a sample’s panel must reside on one rack; they cannot be split between two racks.
- Cleaning tubes are always located in Position 39 (bleach) and 40 (DI water) on a rack. Cleaning tubes are required on the last rack and can be required on other racks if you are running multiple assays. Cleaning is automatically performed between assays and at the end of the Worklist. If 39 or 40 tubes are assigned on the last rack, the cleaning tubes can be put on in Position 39 or 40 on any unassigned rack.

Follow these steps to assign racks.

1. Click the Assign Rack button in the Worklist view.

The Assign Rack dialog appears, displaying the suggested tube positions on the rack map for the first sample. A rack break is represented by a horizontal line, and indicates the start of a new rack (Figure 3-7).
2 Select samples in the Sample list to view the tube and reagent assignments for each tube in the panel.

The appropriate number of tubes in the rack map are numbered and colored red, and the tube numbers and corresponding reagents are displayed in a scrollable list. By default, tubes from different assays are assigned to different racks, as the following table illustrates.

<table>
<thead>
<tr>
<th>Entry Number</th>
<th>Assay</th>
<th>Rack</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CellQuest</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>MultiSETa</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>MultiSETb</td>
<td>2</td>
</tr>
</tbody>
</table>

a. like assays

3 Make any necessary changes in the rack map by inserting or deleting rack breaks.

You can remove a rack break only when there is sufficient space on the previous rack to contain all tubes from the next sample’s panel.
To insert a rack break, select a sample in the Sample list; then click Insert Break. The rack break is inserted above the selected sample.

To delete a rack break, select the line in the Sample list; then click Delete Break. Make sure you start at the top of the list.

After inserting or deleting rack breaks, the Sample list is automatically adjusted.

Different panels in BD CellQuest Pro software can be associated with different mix settings. BD Biosciences recommends that you consider mix settings when you group samples from different BD CellQuest Pro panels on the same rack.

4 Assign a Rack ID.

Choose an unused rack ID from the Rack ID pop-up menu. Rack IDs are printed on top of each rack and on a label inside the rack which can be read optically by the Loader.

After choosing a rack ID, the Sample list displays the chosen number. Once a sample entry is assigned to a rack, entries in the Location, Assay, and Panel Name columns cannot be changed, and rack breaks cannot be inserted or deleted.

5 Select a printing option to print the Rack Manifest Report.

Click Print Rack to print a report for the current rack; click Print All Racks to print reports for all assigned racks. The Rack Manifest report lists sample information, reagent names, and tube locations for each sample, and cleaning tube information and locations. The report also contains a rack map showing the corresponding sample entry numbers for each tube. Cleaning racks print only if you choose Print All Racks.

Having a printout of rack assignments makes loading the samples into the rack easier. You cannot view this report on the screen; it must be printed to be seen.
6 Click OK when you are satisfied with the rack assignments.

The Location column in the Worklist view shows the rack IDs and starting tube positions for each sample.

7 To edit rack assignments, click Release Rack.

Use the Release Rack dialog to edit entries after racks have been assigned or to reassign racks.

Select the racks to release by selecting their checkboxes or by clicking Select All; then click Release. If you release a rack with samples that haven’t been run, be sure to print a new Rack Manifest and verify that the samples are loaded into the rack according to the new tube positions.
Once you define all sample and rack information and save the Worklist document, you are ready to acquire samples.

The following topics are covered in this chapter:

- Setting Up the Loader on page 68
- Running Samples on page 70
- Rerunning a Full Entry on page 78
- Viewing the Summary Report on page 79
Setting Up the Loader

Follow these steps to set up the Loader rack(s) and install the first rack on the cytometer. If you are running samples that were prepared on a BD FACS Sample Prep Assistant (SPA), skip to step 3 on page 69. Then proceed to Running Samples on page 70.

1. Remove the Loader rack from the instrument, if needed.

   Slide the Loader cover forward and pull out the Loader drawer. Place your thumb on the center spindle, and press down with your thumb while gently pulling up on the rack handle with two fingers, as shown in Figure 4-1.

   ![Figure 4-1 Removing a rack](image)

2. Vortex the sample tubes and place them in the rack(s) according to the Rack Manifest.

   If the Rack Manifest indicates cleaning tubes are required on that rack, load a tube containing 3 mL of 10% bleach in Position 39 and a tube containing 3 mL of deionized water in Position 40.

   If the last rack is full of sample tubes, use another rack for cleaning. The cleaning rack does not need to be assigned. Worklist Manager prompts you...
to install a rack with bleach and water tubes at the completion of sample acquisition.

⚠️ Make sure the actual tube loading sequence matches what is printed on the Rack Manifest.

If loaded racks sit for an extended period of time before you run the samples on the Loader, you must vortex the tubes again before proceeding.

3 Install the first rack to be acquired on the Loader.

Position the spindle hole in the rack handle over the center spindle of the Loader drawer. Rotate the rack until the alignment guide pin fits into the small alignment hole at the top of the rack. Press down firmly to seat the rack.

![Figure 4-2 Installing the Loader rack](image)

4 Close the Loader drawer completely, and install the Loader cover.

The Loader scans and positions the rack at tube Position 1.

⚠️ To operate the Loader, the cover must be in place on the Loader drawer. Tubes will not be loaded if the cover is off, and currently running tubes will be unloaded if the cover is removed during a run.
Running Samples

After you click Run Tests at the Worklist view, Worklist Manager runs the samples listed in the Worklist. If a Worklist contains both BD CellQuest Pro and BD Multiset assays, a short cleaning cycle (approximately 3 minutes) is performed as each completed application closes. When the Worklist is complete, a long cleaning cycle (approximately 12 minutes) is performed. When the final cleaning cycle is complete, the Summary Report appears in the Summary view.

For application-specific options during acquisition, see BD CellQuest Pro Options During Acquisition on page 74 or BD Multiset Options During Acquisition on page 75.

1 Place the flow cytometer in RUN mode and choose the appropriate flow rate.

**Tip** Before proceeding with step 2, make sure the paper tray for the printer you are using has a sufficient supply of paper. If the printer runs out of paper in the middle of a run, the run will stop.

2 Click Run Tests at the Worklist view.

If you have not yet saved the Worklist document, a dialog appears, instructing you to do so.

The following initialization steps are performed:

- The Loader checks the Rack ID.
- Tube locations are checked against the Rack Manifest.
- The acquisition software is launched.

A number of things happen as the acquisition software is launched.

- The application-specific document for the first sample is opened.
- Instrument settings are downloaded to the cytometer, if a file was linked to the sample’s panel in Assay Settings.
• The start-of-rack mix occurs.

• Sample acquisition begins.

**NOTICE** If a Loader error occurs during a run, a dialog appears with options to Retry, Continue, or Stop Run. Click Retry to recheck the status; click Continue to complete acquisition of that tube without fixing the error condition. Errors are noted on the Summary Report.

If a file-naming conflict occurs during the run, the application modifies the file name by adding an uppercase letter after the tube number. See File-Naming Conflict During a Run on page 34 for more information. The Worklist is aborted if the conflict cannot be resolved.

3 If prompted, enter or scan the unique carousel ID from the imported SPA Worklist (Figure 4-3), and click Continue.

The following dialog appears if you defined a unique carousel ID in the SPA worklist.

![Figure 4-3 Entering a unique Carousel ID](image)

4 Install the next rack, if prompted.

After acquisition is complete for the first sample or panel, acquisition of the next sample or panel begins. If the next sample or panel uses different instrument settings, the new settings are automatically downloaded to the cytometer. If the next sample or panel uses a different acquisition
document, the first acquisition document is closed, and the next one is opened.

Worklist Manager software automatically launches and closes acquisition software to run their respective panels.

5 When the final cleaning cycle is complete, review the Summary Report.


6 Remove the Loader cover, pull out the Loader drawer, and remove the rack.

7 Install a tube of distilled water on the SIP and place the support arm underneath the tube.

8 Put the cytometer in Standby mode.

9 Quit Worklist Manager software.

Pausing Acquisition

⚠️ To interrupt the Loader when you are running BD Multiset software, always stop the run within BD Multiset software; do not interrupt the run from Worklist Manager software. See Interrupting BD Multiset Software on page 75. In addition, it is not good practice to interrupt a run by removing the Loader cover.

To stop the Loader run when you are using BD CellQuest Pro software, do the following.

1 Click Stop at the Worklist view.

2 When the countdown dialog appears, click Yes.

3 Click the Worklist Manager background view to activate it, and click Stop.
Alternately, activate Worklist Manager by clicking the application icon in the Dock.

4 A 15-second countdown dialog appears; click Yes to stop acquisition of this tube.

Choose from the following options.

- Rerun—reruns the current tube
- Next Tube—skips to the next tube on the Worklist
- Next Sample—advances the Loader to the first tube of the next sample (if available), leaving the previous sample incomplete
- Stop Run—advances to the Summary Report view

**NOTICE** If you abort a run, the Long Clean is not performed automatically. To clean after an aborted run, use the Cleaning option in LoaderManager’s Maintenance and Diagnostics window. See Loader Shutdown on page 82 for details.

The Worklist status icons indicate which samples have or have not been run. See Creating a Worklist on page 52 for a description of the icons.
BD CellQuest Pro Options During Acquisition

You can use BD CellQuest Pro software controls during acquisition with the Loader. Acquisition will proceed, uninterrupted, unless you click any of the following Acquisition controls:

- **Pause**—suspends acquisition. The Loader keeps the sample running, but data collection is suspended.
- **Resume**—continues collecting events, adding events to those already acquired
- **Restart**—begins collecting events, discarding the events already acquired
- **Save**—stops collecting events, saving the events already acquired to the data file
- **Abort**—stops acquisition of the current tube only (discards the events already acquired for this tube but does not abort the entire Worklist)

To make instrument setting adjustments during acquisition, click Pause, click Abort, and then select the Setup checkbox in the Acquisition Control window. After you make the needed adjustments, deselect the Setup checkbox, and then click Acquire to continue with automated acquisition.

⚠️ Be sure to enter Setup mode before changing instrument settings. If you change instrument settings while not in Setup mode, the data file will contain data acquired using the old and the new instrument settings.

Worklist Manager aborts acquisition of a tube and stops the Worklist run if acquisition is not completed within 10 minutes. However, if you are acquiring a BD CellQuest Pro document with a collection criteria based on time, the BD CellQuest Pro–specified time overrules Worklist Manager.

**NOTICE** Any changes made to an Experiment document during a Worklist run remain in effect only while the document is open. Changes are not saved when the document is closed automatically by Worklist Manager software.
BD Multiset Options During Acquisition

When Worklist Manager launches BD Multiset software, you will have access only to the Acquisition, Analysis, Lab Report, and Physician Report views. You will not be able to stop and view a Summary Report at the Summary view. This report is created only when Worklist Manager quits the application.

The following information in a Schedule document can change when that document is run with Worklist Manager, but these changes are not saved.

- Data Source becomes *From Cytometer*.
- View Reports defaults to 5 seconds unless a value of 2 or 0 was saved in the Schedule document.
- Panel preference becomes *Run Any Panel*.
- All sample information is eliminated.

**Interrupting BD Multiset Software**

⚠️ To interrupt the Loader when you are running BD Multiset software, always stop the run within BD Multiset software; do not interrupt the run from Worklist Manager software. In addition, it is not good practice to interrupt a run by removing the Loader cover.

There are two places where you can interrupt BD Multiset software: at the Acquisition view or the Lab Report view. To make instrument setting adjustments, pause at the Acquisition view; to perform manual gating, pause at the Lab Report view.
1. Within BD Multiset software, click Pause at the Acquisition view, if necessary.

When you click Run Tests at the Worklist view, BD Multiset software launches and events appear in plots at the Acquisition view. Acquisition begins after a defined countdown. You can pause acquisition while the countdown dialog is present.

2. Choose from the following options at the Acquisition view.

- To make instrument adjustments, choose Det/Amps, Threshold, or Compensation from the Cytometer menu. Adjust the settings using the appropriate software controls. Refer to the *BD Multiset Software Reference Manual* for more information.

⚠️ Instrument settings adjustments apply only to the current tube; they are not saved with the Schedule document.

- To continue acquisition, click Acquire.

3. Within BD Multiset software, click Pause at the Lab Report view, if necessary.

If you specified to view reports for 2 or 5 seconds in the BD Multiset Set Up view, the Lab Report remains on display for the specified time and a countdown dialog appears. You can pause at the Lab Report view while the countdown dialog is present.
Choose from the following options at the Lab Report view.

- To perform manual gating, click Manual Gate. You can make adjustments to the expert gate or the attractors and change the parameters displayed for the tube just analyzed. Refer to the *BD Multiset Software Reference Manual* for more information.

The Manual Gate button is enabled only when the data source is *From Cytometer: Acquisition with Analysis*. Changes to the attractors or the display apply only to the current tube; they are not saved with the Schedule document.

- To rerun the tube just acquired on the cytometer, click Rerun. You can save the original data or you can overwrite it. Note that you can choose to rerun an individual tube only at the Lab Report view; to rerun all tubes in a panel, see Rerunning a Full Entry on page 78.

- To proceed with acquisition and analysis for the next tube, click Continue. If this was the last tube in the panel, BD Multiset software closes and Worklist Manager displays the Summary Report view.

- To skip to the next tube or the next sample, click Skip. Note that you cannot skip tubes when running control panels.

- To stop the run, click Stop. A verification dialog appears asking if you want to quit. If you click Yes, BD Multiset software quits and the Worklist Manager Summary Report view appears.

Choose Stop only if you want to quit the clinical application. If you abort a run, the Long Clean is not performed automatically. To clean after an aborted run, use the Cleaning option in LoaderManager’s Maintenance and Diagnostics window. See Loader Shutdown on page 82 for details.
Rerunning a Full Entry

You can perform up to five full-entry (entire panel) reruns either at the completion of a Worklist or if a Worklist is completely stopped. You must initiate a full-entry rerun from the Worklist view.

See Naming a Rerun Tube on page 35 for information on file naming conventions.

1  Click the Status icon of the sample you want to rerun at the Worklist view. Status icons indicate the state of the run. See Creating a Worklist on page 52 for a description of the various Status icons.

The Sample Run Status window appears, listing the status of all tubes in the selected tube’s panel.

2  Click Rerun to rerun the entire panel.

Note that you cannot choose to rerun individual tubes. To cancel the rerun and return to the Worklist view, click OK.
Viewing the Summary Report

A Summary Report appears in the Summary view at the completion of every run. The Summary Report lists all sample and reagent information, the rack location, the data files saved, and the status of the run.

You can save and print the Summary Report by choosing the appropriate commands from the File menu. If you clicked the Summary Report checkbox at the Set Up view, the report is automatically saved when the Worklist is completed or stopped.

At the Summary view you can quit the program or choose to run more samples by clicking the Worklist icon.
If an error occurred during the run, an error message appears on the Summary Report. There are four types of error messages; refer to the indicated documentation for assistance in troubleshooting errors.

- For file-saving errors, see WorklistManager Troubleshooting on page 104 or refer to your acquisition software manual.

- For Loader errors, see Loader Troubleshooting on page 100.

- For cytometer errors, refer to your instrument manual.

- For multiple errors, refer to the appropriate documentation.
The following topics are covered in this chapter:

- Loader Shutdown on page 82
- Loader Diagnostics on page 84
- Unscheduled Maintenance on page 86
- Modifying the Cytometer for Non-Loader Use on page 95
Loader Shutdown

This section describes how to perform a Long Clean using Loader Manager software, and how to shut down the Loader. Note that a Long Clean is performed automatically at the end of each Worklist run. Run the cleaning procedure manually if you stop a Worklist before it is complete, or for additional, optional cleaning after the procedure has been run automatically.

1. Quit Worklist Manager software, if it is open.

2. Launch Loader Manager software.

   The Loader Status window appears.

   ![Loader Status Window]

3. Click the Maintenance button, or press Command-M.

   The Maintenance and Diagnostics dialog appears.

   ![Maintenance and Diagnostics Dialog]
4 Verify the Long Clean option is selected; click Run.

The Long Clean procedure runs bleach and distilled water through the cytometer for approximately 12 minutes.

A message appears, prompting you to install bleach and rinse tubes.

5 Set up a Loader rack with cleaning tubes; install the rack on the Loader.

Install a tube containing 3 mL of 10% bleach in position 39 and a tube containing 3 mL of DI water in position 40.

6 Click Run.

A cleaning status dialog appears.

7 When the cleaning cycle is complete, remove the Loader cover and rack.

8 Install a tube of distilled water on the SIP.

9 Put the cytometer in Standby mode.

10 Quit Loader Manager software.

11 Vent the sheath tank and turn off the cytometer.

12 Switch off the Loader power on the keypad.

13 Push in the Loader drawer; leave the Loader rack and cover off.
Loader Diagnostics

Diagnostic features in Loader Manager software allow you to access an error log, check the calibration of the Loader’s tube lifter, and set or change the connection port. Note that these features are available only when you launch Loader Manager software independent of Worklist Manager software.

- To view the error log, see Accessing the Error Log on this page.
- To check the tube lifter calibration, see Checking Tube Lifter Calibration on page 85.

Accessing the Error Log

The Error Log lists the last 100 hardware errors logged by the system. You can print the log for use in Loader diagnostics or troubleshooting.

1. Quit Worklist Manager software, if needed, and launch Loader Manager.
2. Click the Maintenance button in the Loader Status window.
3. Click the Error Log button in the Maintenance and Diagnostics window.

The Loader Error Log dialog appears (Figure 5-1 on page 85), listing the date, time, and description of the last 100 hardware errors.
Figure 5-1  Loader Error Log dialog

4  Click Print to print the log, if needed.

5  Click Done to return to the Maintenance and Diagnostics window.

6  Click Done to return to the Loader Status window.

Checking Tube Lifter Calibration

Tube lifter parameters are used to adjust the tube lifter to ensure proper sealing with the SIP. You might be asked to communicate these settings to BD Biosciences personnel if you call for troubleshooting assistance.

1  Quit Worklist Manager software, if needed, and launch Loader Manager software.

2  Click the Maintenance button in the Loader Status window.
3 Click Check Lifter Parameters in the Maintenance and Diagnostics window, and click Run.

The Check Lifter Parameters dialog appears (Figure 5-2).

![Check Lifter Parameters dialog](image)

**Figure 5-2** Check Lifter Parameters dialog

4 Click Print to print a record of the stored lifter parameters, if needed.

5 Click Done to return to the Maintenance and Diagnostics window.

**Unscheduled Maintenance**

Perform the following maintenance procedures when indicated by an error message or you observe a decline in instrument performance.

- For communication problems between the Loader and the cytometer, see Verifying Connection Ports on page 87.

- For tube pressurization issues, see Replacing the Loader Seal on page 88. (Change the seal only after you have tried all other troubleshooting solutions listed in Test tube not pressurizing on page 101.)
• To replace the fuse in the electronics module, see Replacing a Loader Fuse on page 90.

• To correct a repeated vertical timeout error, see Cleaning the Tube Lifter on page 93.

Verifying Connection Ports

The Loader electronics module connects to the computer via a Keyspan USB-to-serial adapter. If you are experiencing communication problems between the Loader and the cytometer, verify that the cables are securely connected, and the correct port is selected in Loader Manager Preferences.

1 Check the cable connections between the Loader electronics module and the adapter (Figure 5-3).

The cable attaches to the serial port in the electronics module, and to port 2 on the adapter.

NOTICE For Mac OS X computers, the cable should be attached only to adapter port 2 (on the curved side of the adapter).

2 Check the cable connections between the adapter and the computer.

Tip For reliable performance, always plug the adapter directly into a USB port on the computer; do not use a USB hub.
3 Quit Worklist Manager software, if needed, and launch Loader Manager software.

4 Choose LoaderManager > Preferences.

The Serial Port Selection dialog appears.

5 Verify that Print Port (2) is selected; click Save.

If you continue to have connectivity problems after you have checked all cable connections, contact your BD Biosciences service representative.

Replacing the Loader Seal

The Loader seal can become worn over time and need replacement. If you have trouble sealing tubes when using the Loader, you might need to replace this seal. Before replacing the seal, be sure to check other possible causes of sealing problems in Test tube not pressurizing on page 101.

Any instrument surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling instrument hardware. Wear suitable protective clothing and gloves.

1 Turn off the instrument main power.

2 Remove the tube guide retainer and attached tube guide.
Turn the tube guide and tube guide retainer counterclockwise, as shown in Figure 5-4 on page 89.

3 Remove the outer droplet sleeve from the sample injection tube by turning the SIP retainer counterclockwise (Figure 5-5).
Tip  Hold the sleeve as you turn the retainer. The outer sleeve might fall out as you loosen the retainer.

4 Remove the flat, red or white Loader seal.

5 Install the new seal.

**NOTICE**  The Loader accessory kit includes three versions of the seal—a thick, medium, and thin version. Install the next-thickest version, compared to the seal that is currently installed. Make sure it is flush against the sample injection tube.

For reordering information, see Replacement Parts on page 106.

6 Replace the outer droplet sleeve and tighten the SIP retainer.

7 Replace the tube guide retainer and the tube guide.

8 Test the new seal by loading a tube with the Lifter key on the Loader keypad.

**Replacing a Loader Fuse**

There are two fuses located inside the fuse drawer on the back-left corner of the electronics module. Change a fuse only if you are instructed to do so in the troubleshooting section of this reference manual or by a BD Biosciences service representative.

 Protect against the risk of fire by replacing fuses only with those of the specified type and rating. To prevent shock injury or damage to the instrument, turn off the power and unplug the Loader power cord before attempting to change the fuse.

1 Turn off the power to the Loader and the cytometer.

2 Unplug the Loader power cord from the wall outlet.
3 Remove the access panel from below the instrument sheath and waste compartment.

This panel is easily removed by snapping it from the instrument frame.

4 Access the fuse drawer. Remove all the cables from the electronics module and slide the module out from under the cytometer.

5 Place a small screwdriver into the slot at the left of the fuse drawer and pry to pop out the drawer (Figure 5-6).

![Figure 5-6](back_corner_of_electronics_module.png)

*Figure 5-6* Back corner of the electronics module
6 Pull out the fuse drawer, remove the fuses, and examine them (Figure 5-7).

If the filament is broken or if you see any discoloration of the glass, discard the fuse.

![Figure 5-7 Removing fuses](image)

7 Replace any damaged fuses with new fuses from your spares kit.

For reordering information, see Replacement Parts on page 106.

8 Slide the fuse drawer into the electronics module.

The clip should be to the left. Push gently on the drawer until it snaps into place.

9 Reconnect all Loader cables, if required.

Figure 5-8 illustrates the proper cable connections.

![Figure 5-8 Cable connections on the electronics module](image)
10 Plug the AC power cord into the wall outlet, and turn on the Loader power from the keypad control.

11 Replace the access panel on the cytometer.

**Cleaning the Tube Lifter**

The Loader tube lifter might need cleaning if a vertical timeout error is reported by Loader Manager software. Use the Single Commands dialog to load a single tube so you can access the tube lifter.

1 Place an empty test tube in position 1 on a Loader rack, and install the rack on the Loader.

2 Push in the Loader drawer and replace the cover.

3 Confirm that all software applications are closed.

   Use the Dock to make sure that all BD applications are closed.

4 Launch Loader Manager software, and click the Maintenance button.

5 Click Single Commands in the Maintenance and Diagnostics window, and click Run.

   The Single Commands dialog appears, where you can select individual commands and send them to the Loader.
6 Select the Park lifter command in the left column, and click Send.

Ensure the tube number is 1 in the *Enter the tube number to load* field.

7 Once the lifter is raised, switch off the Loader power on the keypad.

8 Remove the Loader cover.

9 Hold the test tube in place with one hand, while you pull out the Loader drawer with the other hand.

10 Remove the Loader rack and the test tube, and place the test tube in the rack.

11 Use a gauze pad and deionized water to wipe the tube lifter shaft and base.

12 Push in the Loader drawer and replace the cover.

13 Switch on the Loader power.

The lifter will automatically lower.

14 Select the Reset controller command in the Single Commands dialog, and click Send.

15 Install a rack with a tube in position 1 and check the tube lifting and sealing.

For other troubleshooting suggestions, see Vertical Timeout Error on page 103.
Modifying the Cytometer for Non-Loader Use

When your Loader is installed, a BD Biosciences service representative removes the Bal seal in the cytometer and installs a Loader seal and a tube guide. This configuration creates the proper seal and pressurization for Loader use. If you want to acquire samples without using the Loader, you must remove the tube guide and replace the Bal seal.

Any instrument surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling instrument hardware. Wear suitable protective clothing and gloves.

1. Turn off the instrument main power.

2. Remove the tube guide retainer and attached tube guide.

   Turn the tube guide and tube guide retainer counterclockwise, as shown in Figure 5-9.

![Figure 5-9 Removing the tube guide](image-url)
3 Remove the outer droplet sleeve from the sample injection tube by turning the SIP retainer counterclockwise.

Tip Hold the sleeve as you turn the retainer. The outer sleeve might fall out as you loosen the retainer.

4 Remove the flat, red or white Loader seal.

5 Install the black, rubber O-ring in place of the Loader seal.

To order a replacement, see Replacement Parts on page 106.

6 Install the Bal seal spring-side up just above the threads for the SIP retainer.

7 Reinstall the SIP retainer and outer droplet sleeve over the sample injection tube.

Gently push the Bal seal in place to seat it. If the seal does not remain in position when you let go of it, hold it with one hand while you reinstall the retainer. The seal will seat as you screw on the retainer.

Tighten the SIP retainer just enough to hold it in place, then slide the outer sleeve over the sample injection tube and into the opening of the retainer. Continue tightening the retainer.
8 Install a sample tube on the SIP to ensure that the outer sleeve has been properly installed.

If the sleeve hits the bottom of the tube, loosen the retainer slightly and push the sleeve up as far as it will go. Tighten the retainer.

9 Adjust the tube stop so it fits snugly under the bottom of an installed test tube.
The tips in this section are provided to help you troubleshoot issues that might arise when using the BD FACS Loader. For additional troubleshooting information, refer to your instrument manual.

If additional assistance is required, contact your local BD Biosciences technical support representative. See Technical Assistance on page x.

Troubleshooting suggestions in this chapter are grouped under the following headings:

- Loader Troubleshooting on page 100
- LoaderManager Troubleshooting on page 103
- WorklistManager Troubleshooting on page 104
## Loader Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No LED display on Loader keypad</td>
<td>Loader power not turned on</td>
<td>Switch on the Loader power on the keypad.</td>
</tr>
<tr>
<td>Loader power cord not plugged in</td>
<td></td>
<td>Switch off the power, plug in the Loader power cord, and switch the power back on.</td>
</tr>
<tr>
<td>Main power switched off on Loader electronics module</td>
<td>1 Turn off the power on the keypad.</td>
<td></td>
</tr>
<tr>
<td>2 Remove the front access panel from the cytometer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Reach to the back left corner of the electronics module and press the switch to the right (while looking from the front).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 Turn on the Loader keypad power.</td>
<td>If the LED display appears, reattach the access panel; if the LED display does not appear, see the next cause.</td>
<td></td>
</tr>
<tr>
<td>Loader electronics module fuse blown</td>
<td></td>
<td>Replace the fuse. See Replacing a Loader Fuse on page 90.</td>
</tr>
<tr>
<td>Incorrect rack spin</td>
<td>Rack not engaged with alignment pin on drawer</td>
<td>Rotate the rack on the spindle until the alignment guide pin engages with the alignment hole in the rack, and press down. See Figure 4-2 on page 69. If the problem persists, contact BD Biosciences for assistance.</td>
</tr>
</tbody>
</table>
## Loader Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test tube not pressurizing</td>
<td>Fluidic control switch not in RUN</td>
<td>Turn fluidic control switch to RUN.</td>
</tr>
<tr>
<td>Test tube cracked</td>
<td></td>
<td>Replace test tube.</td>
</tr>
<tr>
<td>Sheath tank not pressurized</td>
<td></td>
<td>Make sure the vent valve is closed and the sheath reservoir cap is securely on.</td>
</tr>
<tr>
<td>SIP outer droplet sleeve not properly installed</td>
<td></td>
<td>Loosen the SIP retainer, push the sleeve up until it seats properly, and then tighten.</td>
</tr>
<tr>
<td>Tube Lifter Parameters not correctly set</td>
<td></td>
<td>Check the lifter parameters in LoaderManager software. See Checking Tube Lifter Calibration on page 85. Compare these values to the ones provided by your service representative. If they do not match, contact BD Biosciences for assistance.</td>
</tr>
<tr>
<td>Difference between Loader sealing and manual sealing (Bal seal)</td>
<td>See Modifying the Cytometer for Non-Loader Use on page 95 for instructions on reinstalling the Bal seal. Manually check test tube sealing. If tube still does not seal, the problem is with the cytometer and not the Loader. Refer to the appropriate instrument guide for additional troubleshooting information.</td>
<td></td>
</tr>
<tr>
<td>Worn Loader seal</td>
<td></td>
<td>Replace the seal as described inReplacing the Loader Seal on page 88.</td>
</tr>
</tbody>
</table>

**NOTICE** This should be done only after checking all other troubleshooting solutions.
## Loader Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication problem between Loader and computer</td>
<td>Loader power not on</td>
<td>Switch on the Loader power on the keypad.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Quit the software and relaunch.</td>
</tr>
<tr>
<td></td>
<td>Loose or damaged cable connecting Loader to computer</td>
<td>Shut down the computer and switch off the Loader power. Check the cable connections between the computer and the Keyspan adapter. Remove the access cover from the cytomter, and check the connection between the adapter and the electronics module. See Verifying Connection Ports on page 87.</td>
</tr>
<tr>
<td>Wrong communication port selected in LoaderManager software</td>
<td>Choose LoaderManager &gt; Preferences. Check that the selected port corresponds to the adapter port the cable is plugged into. If it is not, change the Preference, save, quit the software, and relaunch. See Verifying Connection Ports on page 87.</td>
<td></td>
</tr>
<tr>
<td>Tube stuck message displayed repeatedly</td>
<td>Firmware not clearing error message</td>
<td>Remove the Loader cover, even if the tube does not appear to be stuck. Put the tube back into the rack. Reinstall the cover and click Retry.</td>
</tr>
</tbody>
</table>
# LoaderManager Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Timeout Error</td>
<td>Test tube not completely raised</td>
<td>Make sure the Loader drawer is completely shut. Also, make sure the test tube is free of unnecessary labels or tape.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Tube lifter hitting rack during ascent</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Make sure the rack is properly engaged with the alignment guide pin. If the problem persists, contact BD Biosciences for assistance.</td>
</tr>
<tr>
<td>Spillage causing tube lifter to</td>
<td></td>
<td><strong>Clean the tube lifter. See Cleaning the Tube Lifter on page 93.</strong></td>
</tr>
<tr>
<td>bind</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Invalid rack ID</td>
<td>Rack not spinning properly</td>
<td><strong>Rotate the rack on the spindle until the alignment guide pin engages with the alignment hole in the rack, and press down. See Figure 4-2 on page 69. If the problem persists, contact BD Biosciences for assistance.</strong></td>
</tr>
<tr>
<td>Incorrect rack loaded</td>
<td></td>
<td><strong>Use the rack ID assigned in WorklistManager software, and load the tubes according to the Rack Manifest.</strong></td>
</tr>
<tr>
<td>Invalid tube sequence</td>
<td>Incomplete scan resulting from an interrupt</td>
<td><strong>Remove and re-install the Loader cover.</strong></td>
</tr>
<tr>
<td></td>
<td>Wrong tubes installed</td>
<td><strong>Check the Rack Manifest Report for proper tube locations; make sure cleaning tubes are in place, if required.</strong></td>
</tr>
</tbody>
</table>
WorklistManager Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD CellQuest Pro Experiment document(s) not appearing in Panel pop-up menu in Assay Settings dialog at Worklist view</td>
<td>Experiment document(s) not located in correct folder</td>
<td>Place Experiment document(s) for use with WorklistManager software in the CellQuest Experiments Folder in the WorklistManager Folder.</td>
</tr>
<tr>
<td>Panel not selected in Experiment document(s)</td>
<td></td>
<td>Open document in BD CellQuest Pro software and load the panel in the Acquisition Browser. See Defining a BD CellQuest Pro Experiment Document on page 38.</td>
</tr>
<tr>
<td>Instrument settings files not appearing in Instrument Settings pop-up menu in Assay Settings dialog</td>
<td>Instrument settings not located in correct folder</td>
<td>Place instrument settings files in the Instrument Settings Files folder in the BD Files folder.</td>
</tr>
<tr>
<td>MultiSET not listed in the Assay pop-up menus at Set Up view, Worklist view, or Assay Settings dialog</td>
<td>PanelReagentFile alias missing from ClinApps Info Folder</td>
<td>Re-install BD Multiset software.</td>
</tr>
<tr>
<td>BD CellQuest Pro timeout during acquisition, and event count not achieved within 10-minute time limit</td>
<td>Time not included in Collection Criteria</td>
<td>Redefine the Experiment document with Collection Criteria set to Event Count or Time. See Defining a BD CellQuest Pro Experiment Document on page 38.</td>
</tr>
<tr>
<td>BD Multiset timeout during acquisition</td>
<td>Poor sample preparation; ie, sample too dilute</td>
<td>Prepare new sample and re-acquire.</td>
</tr>
<tr>
<td>Unusual side scatter in BD Multiset results</td>
<td>Inappropriate mix settings at Assay Settings dialog (Set Up view)</td>
<td>Use the default assay mix settings.</td>
</tr>
</tbody>
</table>
## Appendix A

### Technical Specifications

<table>
<thead>
<tr>
<th>Installation Requirements</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power:</strong></td>
<td></td>
</tr>
<tr>
<td>120 VAC ±10%, 60 Hz ±5%</td>
<td></td>
</tr>
<tr>
<td>100 VAC ±10%, 60 Hz ±5%</td>
<td></td>
</tr>
<tr>
<td>200/240 VAC ±10%, 50 Hz ±5%</td>
<td></td>
</tr>
<tr>
<td><strong>Size:</strong></td>
<td></td>
</tr>
<tr>
<td>width—91 cm (36 in)</td>
<td></td>
</tr>
<tr>
<td>depth—61 cm (24 in)</td>
<td></td>
</tr>
<tr>
<td>height—18 cm (7 in)</td>
<td></td>
</tr>
<tr>
<td><strong>Weight:</strong></td>
<td>34 kg (75 lb)</td>
</tr>
<tr>
<td><strong>Temperature:</strong></td>
<td>16–29°C (60–85°F)</td>
</tr>
<tr>
<td><strong>Recommended work space:</strong></td>
<td></td>
</tr>
<tr>
<td>BD FACStation + BD FACSCalibur + Loader</td>
<td>71&quot;L x 39&quot;D x 52&quot;H</td>
</tr>
<tr>
<td><strong>Total weight:</strong></td>
<td>175 kg (385 lb)</td>
</tr>
</tbody>
</table>
## Replacement Parts

The BD FACS Loader comes equipped with four racks and an accessory kit, containing spare and replacement parts. Use the following part numbers to order additional racks or replacement parts. These part numbers are current at the time of publication; contact your local BD representative or distributor for up-to-date ordering information. See the title page of this reference manual or refer to our website, www.bdbiosciences.com, for worldwide contact information.

<table>
<thead>
<tr>
<th>Product Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carousel kit, racks 1–4</td>
<td>332727</td>
</tr>
<tr>
<td>Carousel kit, racks 5–8</td>
<td>332728</td>
</tr>
<tr>
<td>Carousel kit, racks 9–12</td>
<td>332729</td>
</tr>
<tr>
<td>Carousel kit, racks 13–16</td>
<td>332730</td>
</tr>
<tr>
<td>BD Falcon 12 x 75-mm tubes (bag of 125)</td>
<td>343675</td>
</tr>
<tr>
<td>Tube guide</td>
<td>19-66208-00</td>
</tr>
<tr>
<td>Tube guide retainer</td>
<td>19-66206-00</td>
</tr>
<tr>
<td>Spare fuses (four each):</td>
<td></td>
</tr>
<tr>
<td>• 2.5 A, 250 V (US)</td>
<td>343565</td>
</tr>
<tr>
<td>• 3.15 A, 250 V (Asia)</td>
<td>38-30049-00</td>
</tr>
<tr>
<td>• 1.25 A, 250 V (Europe)</td>
<td>38-30050-00</td>
</tr>
<tr>
<td>Loader seal (three each):</td>
<td></td>
</tr>
<tr>
<td>• thick (0.188 cm thick)</td>
<td>19-66379-03</td>
</tr>
<tr>
<td>• medium (0.125 cm thick)</td>
<td>19-66379-01</td>
</tr>
<tr>
<td>• thin (0.093 cm thick)</td>
<td>19-66379-02</td>
</tr>
<tr>
<td>Black, rubber O-ring</td>
<td>88-20040-00</td>
</tr>
<tr>
<td>Bal seal</td>
<td>88-20085-00</td>
</tr>
<tr>
<td>Keyspan USB adapter</td>
<td>344299</td>
</tr>
</tbody>
</table>
A
acquisition
controls, CellQuest Pro 74
documents 38
Multiset options 75
pausing 72, 75
start delay 48
starting 70
timeout 104
tube order 62
adding custom columns 30
adjusting
column width 53
instrument settings 74, 76
arrow, starting 62
assay settings 47
assays
assigning to samples 54
saving options 45
sorting 56
assigning
assays 54
rack IDs 65
racks 63
assistance, technical x

B
Bal seal, reinstalling 95
barcode scanner 54
BD Applications folder 19
BD CellQuest Pro See CellQuest Pro.
BD FACSComp See FACSComp.
BD Multiset See Multiset.
breaks, rack 64
button panel 25

C
cables, Loader 87, 92
carousel ID, SPA 71
CellQuest Pro
acquisition options 74
automatic printing option 49
Experiment document 38
file naming 33
missing Experiment document 102, 104
timeout 104
choosing assays 45
cleaning
cycles 70, 82
tube lifter 93
tubes 68, 83
columns
preferences 30
resizing 53
communication error 87, 102
compatibility, Worklist Manager 17
components, Loader 12
computer requirements 17
computer-controlled mode 27
cover, Loader 69
custom columns 30
cytometer, modifying for non-Loader use 95

D
data files 32, 45
default Schedule document 42
defining
    acquisition documents 38
    rack ID range 28
    Worklists 52, 54
diagnostics, Loader Manager 84
Disabled status 15

e
editing
racks 66
    Schedule document 42
electronics module, Loader 87, 91
entering sample information 54
errors
    log 84
    SPA import 58
    Summary Report messages 80
    vertical timeout 93, 103
Experiment documents
    defining 38
    missing 102, 104
    saving 41
export files 46

F
FACSComp
    launching 50
    skipping 50
    view 25, 50
FCS data files 32, 45
file name prefix 44

file-naming conventions
    all assays 33
    reruns 35
    run conflict 34, 71
    Worklist Manager files 33
files
    export 46
    importing Worklists 56
    instrument settings 50
    naming conflict 34, 71
    naming conventions 33
    naming rerun tubes 35
    saving 35, 45
    storage locations 45, 46
    Summary Report 32
    tab-delimited 60
    Worklist Manager 32
    XML import requirements 61
fixed assays/panels 54
folders
    BD Applications 19
    CellQuest Experiments 41
    invalid location 45
fuses, replacing 90

H
hardware
    components 12
    requirements 17

I
icon bar 24
    See also Worklist Manager views.
import errors, SPA 58
importing
    tab-delimited files 60
    Worklists 56
    XML files 61
installing
  Bal seal 95
  Loader cover 69
  Loader racks 69
  software 18
instrument settings
  adjusting during acquisition 74, 76
  files 50
  linking to panels 48, 55
  not available 104
invalid
  location 45
  rack ID 103
  tube sequence 103
K
  keypad
    about 15
    no display on 100
L
  launching
    FACSComp software 50
    software 20, 24
  limitations, hardware and software ix
Loader
  about 12
  cables 87, 92
  communication problems 102
  components 12
  connection port 87
  cover, installing 69
  drawer 13
  electronics module 87, 91
  fuses, replacing 90
  keypad 15
  limitations ix
  preferences 28
  rack 15
  seal, replacing 88
  setting up 68
  shutting down 82
  spares kit 106
  status 26
  troubleshooting 100
Loader Manager
  about 26
  diagnostics 84
  installing 18
  launching 20, 24
  maintenance 82
  preferences 88
  troubleshooting 103
log, error 84
M
  manual operation 16, 27
  menu bar 24
  message box 25
  mixing
    manual operation 16
    settings 48
Multiset
- abnormal side scatter 104
- acquisition options 75
- file naming 33
- pausing acquisition 75
- reports 45
- Schedule document 42
- timeout 104
- unable to choose assay 104

N
- naming conventions, file 33

O
- optical sensors 14

P
- panels
  - assigning 54
  - linking settings 48
- parameters, tube lifter 85
- pausing acquisition 72, 75
- preferences
  - columns 30
  - Loader 28
  - Loader Manager 88
- pressurization failure 101
- printing
  - lifter parameters 86
  - options, CellQuest Pro 49
  - Rack Manifest report 65
  - Summary Reports 36, 79

Q
- quitting software 21

R
- rack breaks 64
- rack IDs
  - about 14
  - allowable range 28
  - assigning 65
  - invalid 103
  - SPA 57
- Rack Manifest 65
- racks
  - about 15
  - advancing manually 16
  - assigning 63
  - incorrect spin 100
  - installing 69
  - releasing 66
  - removing 68
  - setting up 68
- registering software 21
- releasing racks 66
- removing
  - racks 68
  - tube guide 95
- reordering parts 106
- replacing
  - Loader fuses 90
  - Loader seal 88
- reports, saving 45
- requirements
  - hardware 17
  - installation 105
  - software 17
- rerunning tubes 35, 73, 77, 78
- reruns, full-entry 78
- running
  - FACSComp 50
  - samples 70
  - single commands 93
sample information
  entering 54
  importing 56
Sample Prep Assistant (SPA)
  global information 59
  importing Worklists 56
  rack IDs 57
  unique carousel ID 71
  Worklist criteria 61
saving
  Experiment documents 41
  files 45
  Summary Reports 36, 45, 79
  Worklist documents 35
scanner, barcode 54
Schedule documents 42
security module 20
serial port selection 88
Set Up view 25, 44
setting up
  Experiment documents 38
  Loader racks 68
  Schedule documents 42
  Worklist settings 44
settings
  assay 47
  instrument 48, 55
  mix 48
shutdown, Loader 82
Sign In view 25, 43
single commands, running 93
skipping FACSComp 50
software
  about 12
  installing 18
  launching 20, 24
  quitting 21
  registering 21
  requirements 17
software requirements 17
Sort by Assay 56
SPA See Sample Prep Assistant (SPA).
spinning problems, rack 100
starting
  arrow 62
  software 20, 24
status
  Disabled 15
  icons, Worklist view 53
  Loader 26
Summary Reports
  about 32
  error messages 80
  printing 36, 79
  saving 36, 45, 79
Summary view 25, 79
T
  technical assistance x
timeout, acquisition 104
troubleshooting
   CellQuest Pro timeout 104
   communication error 87, 102
   invalid rack ID 103
   invalid tube sequence 103
   Multiset timeout 104
   no keypad display 100
   rack spin 100
   side scatter display 104
   tube pressurization 101
   tube stuck message 102
   vertical timeout error 93, 103
Trucount bead lot IDs 42
tube guide, removing 95
tube lifter
   about 13
   cleaning 93
   parameters 85
tubes
   cleaning 68, 83
   compatible 15
   installing in rack 68
   invalid sequence 103
   lifting manually 16
   not pressurizing 88
   pressurization problems 101
   rerunning 35, 73, 77, 78
   stuck 102

U
   unique carousel ID 71

V
   vertical timeout error 93, 103

views
   FACSComp 50
   Set Up 44
   Sign In 43
   Summary 79
   Worklist 52

W
   Worklist Manager
      about 12
      application window 24
      compatibility 17
      file naming 33
      files 32
      installing 18
      launching 20, 24
      preferences 28
      troubleshooting 104
      views 25
   Worklist view 25, 52
   status icons 53
   Worklists
      assigning assays/panels 54
      defining 52, 54
      document file 32
      importing 56
      offline setup 29

X
   XML files, importing 61